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Getting Started with Cisco UCS Director REST API

New and Changed Information
The following table provides an overview of the significant changes to this guide for the current release. The
table does not provide an exhaustive list of all changes, or of all new features in this release.

Table 1: New Features and Changed Behavior in Cisco UCS Director, Release 5.5

Where DocumentedWhat's NewFeature

Downloading the RESTAPI SDKBundle,
on page 6

Download theRESTAPI SDKbundle from
Cisco UCS Director.

Download REST API SDK bundle

How to Use cURL Commands, on page
17

You can use the cURL command to execute
a REST API request.

Using cURL Command

Overview

Why Use the REST API

The Cisco UCS Director REST API allows an application to interact with Cisco UCS Director,
programmatically. These requests provide access to resources in Cisco UCS Director. With an API call, you
can execute Cisco UCS Director workflows and change the configuration of switches, adapters, policies, and
other hardware and software components.

The API accepts and returns HTTP messages that contain JavaScript Object Notation (JSON) or Extensible
Markup Language (XML) documents. The JSON or XML payload contained in an HTTP message describes
a method or managed object (MO) in Cisco UCSDirector. You can use any programming language to generate
the messages and the JSON or XML payload.

How the API Works

In RESTful APIs, the HTTP method specifies the action you want to perform and the URI specifies the
resource you want to access.

REST API uses the following HTTP methods to perform create, read, update, and delete (CRUD) operations:
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DescriptionHTTP Method

Retrieves the specified resource. GET is a read-only
operation that does not change the engine state.

• The HTTP GET operation must not have a
request body. If information is passed in a GET
request, query parameters must be used instead.

• Unless specified, the HTTP GET operation
returns the configured state. For example, an
HTTPGET operation of the global routing table
returns the dynamic run-time state.

GET

Submits the data to be processed by the specified
resource. The data to be processed is included in the
request body. A POST operation can create a new
resource.

• Every POST request must include a JSON body
containing a definition of the new resource.

• For a POST operation to create a new resource,
the location header in the HTTP response must
contain the complete URL to be used for
subsequent PUT, GET, and DELETE
commands.

• The HTTP POST response to a create request
must have a 201 return code and a location
header containing the URI of the newly created
resource in the HTTP header.

POST

Updates the specified resource with new information.
The data that is included in the PUT operation
replaces the previous data.

• The PUT operation cannot be used to create a
new resource.

• The request body of a PUT operation must
contain the complete representation of the
mandatory attributes of the resource in JSON
format.

PUT
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DescriptionHTTP Method

Deletes a resource.

• If you delete a resource that has already been
deleted, a 404 Not Found response is returned.

• The HTTP DELETE operation must not have
a request body. If information is passed in a
GET request, query parameters must be used
instead.

DELETE

How to Use the REST API

To access the REST API browser through Cisco UCS Director, a valid Cisco UCS Director user account and
an API access key are needed. Cisco UCS Director uses the API access key to authenticate API requests. This
access key is a unique security access key code that is associated with a specific Cisco UCS Director user
account. For more information about how to generate an API access key, see Generating an API Access Key,
on page 4.

Youmust pass the RESTAPI access key as a name:value header following standard HTTP syntax and semantic
rules. For example, a valid name:value header is X-Cloupia-Request-Key:
F90ZZF12345678ZZ90Z12ZZ3456FZ789. For more information about the API request header, see How to
Make a REST API Request, on page 11 and RFC2616 Header Field Definitions.

The REST API call can be made in one of the following ways:

• Cisco UCS Director GUI—Cisco UCS Director provides a developer menu option to offer the report
metadata and REST API Browser for developers. To access these features, enable the developer menu.
For more information about how to enable the developer menu, see Enabling the Developer Menu
Options, on page 7.

On enabling the developer menu, you gain access to the following features:

◦Report Metadata—The report Metadata enables you to view the REST API URL for every report
displayed in Cisco UCS Director. For more information about how to access Report Metadata, see
Accessing the Report Metadata, on page 9.

◦RESTAPI Browser—The RESTAPI Browser is accessible from theOrchestrationmenu of Cisco
UCS Director. The REST API Browser provides API information and API code generation
capabilities that make it easy to see and work with all the available APIs, including both the REST
APIs and the Java APIs. For more information about how to access REST API Browser, see Using
the REST API Browser, on page 8.

• REST Client—The REST Client is a useful widget for parsing and viewing API requests and responses.
In this widget, you can enter a REST URL and apply an HTTP method such as POST, PUT, or DELETE
to the URL for data manipulation. The REST Client provides a simple user interface for entering a URL
to fetch data from the Cisco UCS Director server.

• If you are using Mozilla Firefox, download RESTClient from Add-ons for Firefox.

• If you are using Google Chrome, download Advanced REST Client from the Chrome Web Store.
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If you are logged in to Cisco UCS Director, use any supported web browser to send API
requests and get responses.

Note

• Code—The Sample Java Code tab of the REST API Browser tab provides a code snippet that can be
used to automate the management services.

The Cisco UCS Director SDK binary downloaded from the software download area or the DevNet site
includes a sample project that can be used as a platform for executing client code.

Prerequisites
Before you start using the Cisco UCS Director SDK, make sure that:

• Cisco UCS Director is installed and running on your system. For more information about how to install
Cisco UCS Director, refer the Cisco UCS Director Installation Guide.

• The Cisco UCS Director SDK is installed on your system.

• You have Java Version 1.8 for your Java development environment.

You need Java Version 1.6 if you have release 5.3 or earlier of Cisco UCS DirectorNote

• You have an API access key. For more information about how to generate an API access key, see
Generating an API Access Key, on page 4.

• You have a REST client to execute RESTful web services.

Note • If you are usingMozilla Firefox, download RESTClient fromAdd-ons for Firefox.

• If you are using Google Chrome, download Advanced REST Client from the
Chrome Web Store.

Generating an API Access Key

Step 1 In Cisco UCS Director, click your login name in the upper right.
For example, if you log in as admin, Cisco UCS Director displays admin in the upper right.

Step 2 In the User Information dialog box, click the Advanced tab.
Step 3 To copy the value displayed in the REST API Access Key area, click Copy Key Value.
Step 4 Save the access key in a secure location, and use it in the API request header.

For more information about the API request header, see Request Format.

Step 5 If you want to change the API access key, click Regenerate Key.
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After you generate a new key, the old key code is retired and you cannot use it.

Downloading and Installing Cisco UCS Director REST API SDK Bundle

About the Cisco UCS Director REST API SDK Bundle

The Cisco UCS Director REST API SDK Bundle is part of the Cisco UCS Director REST API. In addition
to documentation, such as Cookbook, the SDK Bundle provides examples that you can use with the REST
API. These examples include test cases and sample code that demonstrates the use of the SDK classes.

The SDK Bundle is delivered in an archive file named ucsd-rest-api-sdk-v2.zip.

Installing the Cisco UCS Director SDK

Step 1 Download the ucsd-rest-api-sdk-x.x.0.0.zip file from the software download area or the DevNet site.
Step 2 Unzip the file.

The ucsd-rest-api-sdk-x.x.0.0 folder is created on the local drive.

This folder includes the following folders and files to assist you in developing applications with the REST API:

• javadocs—This folder contains the Cisco UCS Director REST API Javadocs. The Javadocs cover all classes
provided with the SDK Bundle.

• lib—This folder contains the ucsd-rest-api-sdk-v2.0.jar file. This file is the archive of all classes
and libraries required for managing the Cisco UCS Director.

• src—This folder contains the example test cases and sample code. These tests cases and codes demonstrate the
use of the SDK classes in the ucsd-rest-api-sdk-v2.jar file. The sample code is available in the
src\com\cisco\cuic\api\examples folder.

• .classpath—This file indicates where to look for SDK classes and packages, to the Java Virtual Machine
(JVM) or Java compiler.

• .project—This file is used to import the SDKBundle into the Eclipse IDE. This file is required for development
purposes. It is available at the top level of the archive.

• README.txt—This file contains lists of all components included in the SDK Bundle.

• rest-server.properties—This file contains the properties used by the examples in the
src\com\cisco\cuic\api\examples folder.

Step 3 Add the ucsd-rest-api-sdk-v2.jar file to the Java classpath when compiling and running the client program.
Use Java Version 1.8 to run the Cisco UCS Director SDK.

For Cisco UCS Director Releases 5.3 and previous releases, use Java version 1.6 to run the Cisco UCS Director
SDK.

Note
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Downloading the REST API SDK Bundle

The Cisco UCS Director SDK binaries can be downloaded from the software download area or the DevNet
site. Also, an admin user and an end user can download the SDK binaries from Cisco UCS Director.

Step 1 To download the REST API SDK bundle as an admin user, do the following steps:
a) Log in to Cisco UCS Director.
b) On the menu bar, choose Administration > Downloads.

The following files are displayed:

• REST API SDK—cucsd-rest-api-sdk-bundle.zip

• PowerShell Console—console.exe

• Open Automation SDK—cucsd-open-auto-sdk-bundle.zip

• Custom Tasks Script Samples—cucsd-cloupia-script-bundle.zip

c) Choose the cucsd-rest-api-sdk-bundle.zip file and click Download.
The file is downloaded to the default download location.

Step 2 To download the REST API SDK bundle as an end user, do the following steps:
a) Log in to the Cisco UCS Director Self-Service portal.
b) On the menu bar, click Services.
c) Click the Downloads tab.

The following files are displayed:

• REST API SDK—cucsd-rest-api-sdk-bundle.zip

• PowerShell Console—console.exe

d) Choose the cucsd-rest-api-sdk-bundle.zip file and click Download.
The file is downloaded to the default download location.

List of Deprecated APIs

Developers are encouraged to migrate to the new API, instead of using the deprecated API.

Table 2: Deprecated and New APIs

New APISupported TillDeprecated API

From Cisco UCS Director Release 5.x and later releases, the
UserAPICheckFunds API that is available in the
userAPIGlobal folder is deprecated. To check the available
customer funds, use the UserAPICheckFunds API in the
userAPIChargeBack folder.

Release 4.1userAPICheckFunds
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New APISupported TillDeprecated API

userAPIProvisionRequestRelease 4.1userAPISubmitServiceRequest

userAPIProvisionRequestRelease 4.1userAPISubmitServiceRequestCustom

userAPIVMWareProvisionRequestRelease 4.1UserAPIProvisionRequestWithPortGroup

userAPIGetWorkflowInputsRelease 4.1userAPIGetWorkflows

Release 5.3userAPIImportWorkflows

Release 5.4UserAPICreateAPICContainer

Setting Up the Development Environment

Setting up the Environment for Using the REST API Through the GUI

Enable the developer menu option to access the REST API Browser and Report Metadata information in
Cisco UCS Director. The REST API Browser and Report Metadata features provide you with site-specific
API data.

The HTTP request code provided by the Report Metadata view yields immediate API service results. You
can use these options in every situation where you need API information.

The Cisco UCS Director REST API Browser provides API information and API code generation capabilities
that make it easy to see and work with all of the available APIs, including both the REST APIs and the Java
APIs.

To use REST API in the GUI, perform the following tasks:

• Enabling the Developer Menu Options, on page 7

• Using the REST API Browser, on page 8

• Accessing the Report Metadata, on page 9

Enabling the Developer Menu Options

Before You Begin

Obtain one or more user accounts that provide the same administrative access to data that your application
users will have. Your Cisco IMC Supervisor administrator can explain the data access limitations associated
with different administrator and end-user roles. Youmaywant multiple user accounts to test the user experiences
associated with different data accesses and security controls.

Step 1 In Cisco IMC Supervisor, click your login name in the upper right.
For example, if you log in as admin, Cisco IMC Supervisor displays admin in the upper right.

Cisco UCS Director REST API Getting Started Guide, Release 5.5    
7

Getting Started with Cisco UCS Director REST API
Setting Up the Development Environment



Step 2 In the User Information dialog box, click the Advanced tab.
Step 3 Check the Enable Developer Menu (for this session) check box.

The REST API Browser is activated in the Orchestrationmenu during the current session, and the Report Metadata
option becomes available in the report views opened in the session.

TheAdvanced tab also displays the RESTAPI Access Key code for the account.Tip

Step 4 Close the User Information dialog box.

Using the REST API Browser
The Cisco UCS Director REST API Browser provides API information and API code generation capabilities
that assist and educate developers in the use of all available Cisco UCS Director APIs, including the
XML-formatted REST API and the Java API. The primary view lists the Task folders that contain the APIs.
The task names supply the categories under which the APIs are listed. For example, all the APIs pertaining
to NetApp ONTAP tasks and NetApp OnCommand tasks are available inside the folders with these names.

Before You Begin

• Obtain one or more user accounts that provide the same administrative access to data that your application
users will have. Your Cisco UCSDirector administrator can explain the data access limitations associated
with different administrator and end-user roles. You may want multiple user accounts to test the user
experiences associated with different data accesses and security controls.

• Enable the developer menu option for the session.

Step 1 On the menu bar, choose Policies > Orchestration.
Step 2 Click the REST API Browser tab.

Click the right scroll arrow, if necessary, to navigate to the REST API Browser tab.

Step 3 Open the task folder that contains the API you want to view.
You can use the Search field at the top right corner of the Rest API Browser tab to find a specific API if you
do not know which task folder it belongs to. Enter a string that occurs in the API Resource, Operation, or
Description field to narrow your search. You can also use the other options on that menu bar, such as the Add
Advanced Filter, to help you find a specific API.

Tip

Step 4 Double-click a row that contains an API resource and operation that is required.
The REST API browser displays the following:

• API Examples tab—Displays the API data for your selection and enables you to generate a sample URL. Depending
on the operation and resource that you have selected, this tab might also include data entry boxes that accept
parameter values. If available in a data entry box, click Select to open data search filters that can help you sort and
select the data that you want to enter.

• Details tab—Provides more details about the API, including the API definition, input parameters, and output
parameters.

• Sample Java Code tab—Provides sample code for the API.
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Accessing the Report Metadata
Report Metadata enables you to view the API code used by Cisco UCS Director, including the API request
code for every report displayed in Cisco UCS Director. This code includes a complete URL that is ready to
paste into a browser to send the URL request to Cisco UCS Director. The immediate API responses provide
information for the developer. To see the API request code, navigate to a report and selectReport Metadata.

Before You Begin

• Obtain one or more user accounts that provide the same administrative access to data that your application
users will have. Your Cisco UCSDirector administrator can explain the data access limitations associated
with different administrator and end-user roles. You may want multiple user accounts in order to test
the user experiences associated with different data accesses and security controls.

• Enable the Developer Menu option for the session.

Step 1 In Cisco UCS Director, navigate to the page for which you want to see the API code.
For example, choose one of the following:

• Policies > Orchestration

• Physical > Storage > Storage_Account > Filers

Step 2 Click Report Metadata.
Step 3 In the Information dialog box, review the sample code.

Setting up the Environment for Using the REST API Through the REST Client

The REST Client provides a standalone client that parses and labels the API data in a useful and informative
way. You can also use any supported web browser to send API requests and get responses. Download a
supported REST Client in a web browser to execute the REST URLs.

• In Mozilla Firefox, download RESTClient from Add-ons for Firefox.

• In Google Chrome, download Advanced REST Client from the Chrome Web Store.

Using the REST Client, you can execute the JSON APIs and XML APIs.

The sample JSON-based API URL to retrieve all catalogs using the GET method:
http://<serverip>/ app/api/rest?formatType=json&opName=userAPIGetAllCatalogs&opData={}

The sample XML-based API URL to create a user using the POST method:
http://serverip/cloupia/api-v2/user
<cuicOperationRequest>
<payload>
<![CDATA[
<AddUserConfig>
<userType>Admin</userType>
<!-- Accepts value from the list: userGroupByType-->
<userGroup>1</userGroup>
<mspOrganization></mspOrganization>
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<loginName>apiuser</loginName>
<!-- Accepts value from the list: password-->
<password>bGthbmRhc2E=</password>
<!-- Accepts value from the list: password-->
<confirmPassword>bGthbmRhc2E=</confirmPassword>
<userContactEmail>apiuser@cisco.com</userContactEmail>
<firstName>API</firstName>
<lastName>User</lastName>
<phone></phone>
<address></address>
</AddUserConfig>

]]>
</payload>
</cuicOperationRequest>

The HTTP response of the user creation URL:
HTTP Response Code : 200
Response data :
<?xml version="1.0" encoding="UTF-8" standalone="yes"?><cuicOperationResponse>
<Log><Messages>1</Messages><Message><TimeStamp>2015-08-28 06:55:17.240</TimeStamp>
<Severity>INFO</Severity><Text>User Admin Created Successfully</Text>
</Message></Log><operationStatus>0</operationStatus><response><AddUserConfigResponse>
<OUTPUT_USER_NAME>apiuser</OUTPUT_USER_NAME></AddUserConfigResponse></response>
<responseMap><entry><key>OUTPUT_USER_NAME</key><value>apiuser</value></entry>
</responseMap></cuicOperationResponse>

Setting up the Environment for Using the REST API Through Code

Import the Cisco UCS Director SDK bundle as a Java Project into the Eclipse IDE to execute the code in
Eclipse. For more information about how to import the Cisco UCS Director SDK bundle, see Importing the
SDK Bundle Project into the Eclipse IDE, on page 10. The code can be taken from the Sample Java Code
tab of theREST API Browser. For more information about how to access the REST API Browser, see Using
the REST API Browser, on page 8.

The instruction for using the Cisco UCS Director SDK bundle in Eclipse is captured in the document. The
similar process is applicable for other IDEs but developers must figure out the details for themselves.

Note

Importing the SDK Bundle Project into the Eclipse IDE

Before You Begin

Obtain the SDK Bundle archive and extract the contents to an appropriate folder.

Step 1 In the Eclipse IDE, choose File > New > Java Project.
The Create a Java Project dialog box appears.

Step 2 In the Project Name field, enter a name for the project.
Step 3 Right click the project, and select Import.

The Import dialog box appears.
Step 4 Select File System and click Next.
Step 5 Click Browse and navigate to the folder where you have extracted the SDK Bundle.
Step 6 Click Finish.

The Eclipse IDE displays the SDK Bundle project on the Project Explorer tab.
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How to Make a REST API Request

API clients use an HTTP request to interact with Cisco UCS Director. To pass the REST API access key,
each request must be associated with an HTTP header called X-Cloupia-Request-Key with its value
set to the current REST API access key. For information about how to generate the REST API access key,
see Generating an API Access Key, on page 4.

Requests made to the API have the following characteristics:

• Requests are sent over HTTP.

• Request must contain a valid URL in the one of the following formats:

• JSON Format
http://SERVER/app/api/rest?formatType=json&opName=operationName&opData=
operationData
where:

• SERVER—The IP address or the hostname of the Cisco UCS Director VM.

• formatType—The only supported format that is discussed here is JavaScript Object Notation
(JSON). Set this parameter value to json.

• opName—The API operation name associated with the request. For example,
userAPIGetMyLoginProfile or userAPIGetVMActionStatus.

• opData—Parameters (or arguments) associated with the operation. Cisco UCSDirector uses
JSON encoding of the parameters. If no arguments are required for the operation, use {} as
an empty set. Before you send JSON data in a request, encode the URL by applying escape
characters as appropriate. For details about encoding the URL, see the RFC at
http://www.ietf.org/rfc/rfc1738.txt. For more information about JSON syntax and data types,
see http://en.wikipedia.org/wiki/JSON#Data_types.2C_syntax_and_example. For information
about non-JSON formatted API requests, see Using the REST API Browser, on page 8.

• XML Format
http://server/cloupia/api-v2/group

HTTP method: POST

<cuicOperationRequest>
<payload>
<![CDATA[
<AddGroupConfig>
<groupName>TestGroup</groupName>
<groupDescription></groupDescription>
<parentGroup>0</parentGroup>
<groupCode></groupCode>
<groupContact>jbesai@cisco.com</groupContact>
<firstName></firstName>
<lastName></lastName>
<phone></phone>
<address></address>
<groupSharePolicyId></groupSharePolicyId>
<allowPrivateUsers>false</allowPrivateUsers>
</AddGroupConfig>
]]>
</payload>
</cuicOperationRequest>
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For REST API examples, refer the Cisco UCS Director REST API Cookbook.

About Operations Data Parameters or Arguments

As the method and the API resource type are communicated through the opName, the operation parameters
must present any arguments that you want to designate a specific instance of the resource to be operated upon.

Operations Data Parameter Syntax

The following table shows examples of operations data parameter syntax in JSON format.

How to represent in JSONIf the operation needs the following parameters
(opData)

{}No parameters

{param0:10}One parameter; integer (for example, 10)

{param0:"cloud"}One parameter: string (for example, cloud)

{param0:"cloud",param1:10}Two parameters: a string and an Integer

{param0:null,param1:10}Two parameters: a string with null value and an
Integer

{param0:"cloud",param1:"cloupia",param2:100}Three parameters

Operation Data Parameter Examples

…&opData={param0:"datacenter",param1:"DataCenter1",param2:"STORAGE-ACCOUNTS-T51"

…&opData={param0:"Create NFS Datastore",param1:{"list":[{"name":"Volume Size","value":100},
{"name":"Select Group","value":"14"},{"name":"Select vDC","value":18}]},param2:212}

• param0—Name of the workflow being invoked through the REST API.

• param1—Input being passed to the workflow. If there is more than one input, separate the inputs with
commas and put quotation marks around the input names and values. If there are no inputs, use the
keyword null as the parameter value.

• param2—If this workflow is being invoked as a child workflow of another service request, use the service
request (SR) ID. If this workflow is not invoked as a child workflow, use –1. When –1 is used, a new
service request is created.

Cisco UCS Director provides many complete API requests, formatted as URLs and ready for you to cut
and paste into a browser. See Enabling the Developer Menu Options, on page 7.

Tip
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Context Parameters

In the preceding example, param0 is used to specify the Cisco UCS Director context. The context data value
refers to one of the major domains managed by Cisco UCS Director, for example, global-services,
datacenter, or storage_accounts. A list of the standard Cisco UCSDirector contexts appears in API Request
Context Parameters, on page 14.

Report Parameters

The report parameter value is always the reportId. Typical reportIds include "STORAGE-ACCOUNTS-T51",
"CPU-S0", "VOLUMES--X1", "NETWORK-USAGE-H0", "PORT-SUMMARY-V50", and
"PRIVATE-CLOUD-FREE-STORAGE-S1". The reportId is typically the last parameter listed in an API request for
a report. So, if the context is specified by two parameters, the report parameter is often the third, param2. For
an extensive list of report names and reportIds, categorized by context, see List of Available Cisco UCS
Director Reports, on page 19.

Sample API Request 1

The operation that requests a Login profile refers to the logged-in user, so there is no need for a parameter.
Most other operations need multiple arguments.
http://10.10.1.153/app/api/rest?formatType=json&opName=userAPIGetMyLoginProfile&opData={}

Response to Sample API Request 1
{ "serviceResult":{"userId":"jsmith","firstName":"John","lastName":"Smith","email":
"jsmith@example.com","groupName":"Eng Group","role":"Regular"}, "serviceError":null,
"serviceName":"InfraMgr", "opName":"userAPIGetMyLoginProfile" }

Sample API Request 2

In this request for a report about a chassis for a data center, the operation requires three parameters, which
are typical for a report request.
http://172.17.9.142/app/api/rest?opName=userAPIGetTabularReport&opData=
{param0:"datacenter",param1:"datacenter",param2:"UCS-CHASSIS-T50"}

Response to Sample API Request 2
{"serviceResult":

{"rows":[{"ID":"PHY-ACC;sys/chassis-2",
"Account_Name":"PHY-ACC","DN":"sys/chassis-2",
"Serial_Number":"1558","Model":"N20-C6508","Power_State":"ok",
"Operation_State":"accessibility-problem",
"Configuration_State":"ok","License_State":"license-ok","Servers":5,
"IO_Modules":2,"PSUs":4,"Fan_Modules":8,
"Vendor":"Cisco Systems Inc"},{"ID":"UCSCirrus;sys/chassis-1",
"Account_Name":"UCSCirrus","DN":"sys/chassis-1",
"Serial_Number":"FOX1352GDX4","Model":"N20-C6508",
"Power_State":"redundancy-failed","Operation_State":"power-problem",
"Configuration_State":"ok","License_State":"license-ok","Servers":7,
"IO_Modules":2,"PSUs":4,"Fan_Modules":8,
"Vendor":"Cisco Systems Inc"},{"ID":"UCSM237;sys/chassis-1",
"Account_Name":"UCSM237","DN":"sys/chassis-1",
"Serial_Number":"1557","Model":"N20-C6508","Power_State":"ok",
"Operation_State":"operable",
"Configuration_State":"unsupported-connectivity","License_State":"license-ok",
"Servers":6,"IO_Modules":2,
"PSUs":4,"Fan_Modules":8,"Vendor":"Cisco Systems Inc"},
{"ID":"real108;sys/chassis-1","Account_Name":"real108",
"DN":"sys/chassis-1","Serial_Number":"FOX1352GDX4","Model":"N20-C6508",
"Power_State":"redundancy-failed",
"Operation_State":"power-problem","Configuration_State":"ok",
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"License_State":"license-ok","Servers":7,
"IO_Modules":2,"PSUs":4,"Fan_Modules":8,"Vendor":"Cisco Systems Inc"}],
"columnMetaData":null}, "serviceError":null, "serviceName":"InfraMgr",
"opName":"userAPIGetTabularReport" }}

For advanced Cisco UCS Director API users, the code in the Report Metadata request for the data center
UCS-CHASSIS-T50 report gave the first parameter as param0:"23". In the request used in Sample API
Request 2, the context "datacenter" was substituted for the value "23" and the request was successful.

Tip

API Request Context Parameters

Cisco UCSDirector RESTAPI operations that require parameters typically require the context as a parameter.
There are a few exceptions, notably the operations that pick the context from login information.

If you want to create an API request, you have two options for finding the correct context parameter value to
use:

• Find the correct context name string in the list of standard Cisco UCS Director contexts, and copy it into
the JSON parameter specification in your API request.

• In Cisco UCS Director, navigate to a report that represents the same report data that you want to request
through the API. Find the REST API URL in Report Metadata and use the context parameter(s) that
you find there.

If you find the URL code used to send a request in Cisco UCS Director, you can use some or all of that
API request data to create your own request.

Timesaver

In some scenarios, you might want to use the English (human-readable) name string for the context value
rather than the numeral string value that is provided in the Report Metadata listing of the REST API URL.

Note

Context Field Names and Corresponding Parameter Names

In the listing below, the first element is the name of the field; the second, in quotation marks, is the context
value that you should assign to the parameter representing the context. In most requests for reports, param0
provides the context. If another context parameter (param1) value is required, you can use the value provided
for this parameter in the Report Metadata listing of the REST API URL.

Administrative Contexts

• CONTEXT_TYPE_GLOBAL= "global";

• CONTEXT_TYPE_GLOBAL_ADMIN = "global_admin";

• CONTEXT_TYPE_GLOBAL_SERVICES = "global-services";

• CONTEXT_TYPE_CLOUD = "cloud";

• CONTEXT_TYPE_HOSTNODE = "hostnode";

• CONTEXT_TYPE_CLUSTER = "cluster";
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End User Contexts

• CONTEXT_TYPE_GROUP = "group";

• CONTEXT_TYPE_VM = "vm";

• CONTEXT_TYPE_VDC = "vdc";

• CONTEXT_TYPE_SR = "servicerequest";

Data Center Contexts

• CONTEXT_TYPE_PHYSICAL_DATACENTER = "datacenter";

NetApp Report Contexts

• CONTEXT_TYPE_STORAGE_ACCOUNTS= " storage_accounts";

• CONTEXT_TYPE_STORAGE_FILERS = " netapp_filer";

• CONTEXT_TYPE_STORAGE_AGGREGATES = " storage_aggregates";

• CONTEXT_TYPE_STORAGE_VOLUMES = "storage_volumes";

• CONTEXT_TYPE_STORAGE_LUNS = "luns";

• CONTEXT_TYPE_STORAGE_VFLIERS = "netapp_v_flier";

UCS Report Contexts

• CONTEXT_TYPE_INFRA_COMPUTE_UCSM_ACCOUNT= " ucsm";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_FABRIC_INTERCONNECT = " compute_fbi";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_CHASSIS = " compute_chassis";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_SERVER = "compute_server";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_SERVICE_PROFILE = "service_profile";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_PORT_CHANNEL = "ucs_portchannel";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_ORGANIZATION = "ucs_org";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_SERVICE_PROFILE_TEMPLATE =
"ucs_service-profile-template";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_BOOT_POLICY = "ucs_boot_policy";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_VNIC_TEMPLATE = "ucs_vnictemplate";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_MAC_POOL = "ucs_mac";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_UUID_POOL = "ucs_uuid";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_WWNN_POOL = "ucs_wwnn";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_WWPN_POOL = "ucs_wwpn";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_SERVICE_PROFILE_VHBA = "ucs_sp_vhba";

Cisco UCS Director REST API Getting Started Guide, Release 5.5    
15

Getting Started with Cisco UCS Director REST API
Setting Up the Development Environment



• CONTEXT_TYPE_INFRA_COMPUTE_UCS_SERVICE_PROFILE_VNIC = "ucs_sp_vnic";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_IOMODULE = "ucs_iomodule";

• CONTEXT_TYPE_INFRA_COMPUTE_UCS_SERVER_ADAPTER_UNIT =
"compute_server_adapter_unit";

Network Report Contexts

• CONTEXT_TYPE_INFRA_NETWORK_DEVICE= "network_device";

• CONTEXT_TYPE_INFRA_NET_DEVICE_N1K = " net_device_n1k";

• CONTEXT_TYPE_INFRA_NET_DEVICE_FAB_IC = " net_device_fab_ic";

• CONTEXT_TYPE_INFRA_NET_DEVICE_N5K = "net_device_n5k";

• CONTEXT_TYPE_INFRA_NETWORK_DEVICE_VLAN = "net_device_vlan";

• CONTEXT_TYPE_INFRA_NETWORK_DEVICE_VSAN = "net_device_vsan";

• CONTEXT_TYPE_INFRA_NETWORK_DEVICE_INTERFACE = "net_device_interface";

• CONTEXT_TYPE_INFRA_NETWORK_DEVICE_PORT_PROFILE = "net_device_port_profile";

• CONTEXT_TYPE_INFRA_NETWORK_DEVICE_ZONE = "net_device_zone";

• CONTEXT_TYPE_INFRA_NET_QOS_POLICY = "net_device_qos_policy";

How to Interpret the HTTP Response

The following HTTP status codes are returned by Cisco UCS Director:

• 401 Unauthorized—The API key is not a valid key.

• 200 OK—Cisco UCS Director has processed the request. The actual status of the request is in the body
of the response.

The Cisco UCS Director response body is in JSON format as determined by the FormatType parameter
specified in the API request.
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Components of an API Response

Component Example (Success Scenario)DescriptionAPI Response
Component

"serviceResult":
{"userId":"jsmith",
"firstName":"John","lastName":"Smith",
"email":"jsmith@example.com",
groupName":"Eng Group","role":"Regular"}

If the request succeeds, this
result contains a set of
name-value pairs or a JSON
object or report.

serviceResult

"serviceError":nullIf the request succeeds, the
serviceError is set to null. If the
operation fails, the serviceError
contains the error message.

serviceError

"serviceName":"InfraMgr"Name of the backend service.
Often set to InfraMgr, for
example.

serviceName

"opName":"userAPIGetMyLoginProfile"Name of the operation provided
in the request.

opName

Example: API Response in a Success Scenario
{
"serviceResult":{"userId":"jsmith","firstName":"John","lastName":"Smith",
"email":"jsmith@example.
com","groupName":"Eng Group","role":"Regular"}, "serviceError":null,
"serviceName":"InfraMgr",
"opName":"userAPIGetMyLoginProfile"
}

Example: API Response in a Failure Scenario
{ "serviceResponse":null,
"serviceError":"SERVICE_CALL_EXCEPTION: Service InfraMgr does not support operation test",

"serviceName":"InfraMgr", "opName":"test"
}

API Response (Service Result) Data Types

The service result (payload) sent in a response to a Cisco UCS Director REST API request is specified for
the operation. The service result can be an operation-specific set of name-value pairs, or it can be formatted
as a standard data type for this API, that is, as a report or a JSON object.

How to Use cURL Commands

cURL is a command line tool for getting or sending data using URL syntax. You can use the cURL command
to execute a REST API request.

The following sample shows how to execute the userAPISubmitWorkflowServiceRequest API and pass the
input values:
curl -v -X POST -H 'X-Cloupia-Request-Key:5CF4C115F0034B189616B2B8EBA0F220'
-g 'http://172.17.32.75/app/api/rest?formatType=json&opName=
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userAPISubmitWorkflowServiceRequest&opData={param0:"TestWorkFlowFromAPI",param1:
{"list":[{"name":"A1","value":"Hello"},{"name":"A2","value":"World"}]},param2:-1}'

The following sample shows how to pass the variable value with space in insecure mode:
curl --insecure -v -X POST -H 'X-Cloupia-Request-Key:C97B881CE6B94DFB930765F7AC408xxx'
-g 'https://172.31.234.127/app/api/rest?formatType=json&opName=
userAPISubmitWorkflowServiceRequest&opData={param0:"AddUCSMvlanv1",param1:{"list":
[{"name":"VLAN%20ID","value":"500"},{"name":"VLAN%20DESC","value":"CURLvlantest"}]},param2:-1}'

To run the command in secure mode, install the CA certificate (cacert) file in your system and use the cert
location in curl call using the—cacert curl option.

Note

The following sample shows how to roll back a workflow:
curl --insecure -v -X POST -H 'X-Cloupia-Request-Key:C97B881CE6B94DFB930765F7AC408xxx'
-g 'https://172.31.234.127/app/api/rest?formatType=json&opName=
userAPIRollbackWorkflow&opData={param0:140}'

The -g parameter disables the curl check for nested braces { } [ ]. By default, curl does not allow nested
braces in REST calls.

Note

Cisco UCS Director REST API SDK Bundle – Samples
When you download the SDK, you can find the sample Java code in the
ucsd-rest-api-sdk-v2/src/com/cisco/cuic/api/examples path.

Example: Retrieving VDCs in a Group Based on a Logged-in User
When provisioning VMs, you have to view a list of VDCs available for a particular group and choose the
required VDC. To accomplish this, Cisco UCS Director has to identify the group to which the user belongs
to and retrieve a list of VDCs available for the group. Then, you can create the VDC on which the VM is
provisioned.

Create a workflow with the following REST APIs in sequence:

1 userAPIGetMyLoginProfile—Retrieve the profile of the logged in user to identify the group to which the
user belongs to.

2 userAPIGetAllVDCs—Retrieve a list of VDCs available in the user group.

3 userAPICreateVDC—Create a service request to choose a VDC on which the VM is provisioned.

Step 1 Identify the group to which the user belongs to using the userAPIGetMyLoginProfile API.
Request:
/app/api/rest?formatType=json&opName=userAPIGetMyLoginProfile&opData={}

Response:
{"serviceResult":{"userId":"sdk","firstName":null,"lastName":null,"email":"xyz@test.com",
"groupName":"Default Group","groupId":1,"role":"Regular"}, "serviceError":null,
"serviceName":"InfraMgr","opName":"userAPIGetMyLoginProfile"}

In this example, the user sdk belongs to the DefaultGroup group.
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Step 2 Retrieve a list of VDCs in the user group using the userAPIGetAllVDCs API.
Request:
/app/api/rest?formatType=json&opName=userAPIGetAllVDCs&opData={}

Response:
{ "serviceResult":{"rows":[{"Cloud":"","vDC_ID":1,"Group":"Default Group","vDC":"Default
vDC","Type":"Standard","Lock_State":"Locked","Total_VMs":82,"Active_VMs":72,"Custom_Categories":0,
"vDC_Description":"","Approvers":"","Status":"Default vDC: Not for new provisioning", "Tag":null},
{"Cloud":"VCenter","vDC_ID":4,"Group":"Default Group", "vDC":"SDKcont1" ,"Type":"Container",
"Lock_State":"Unlocked","Total_VMs":2,"Active_VMs":2,"Custom_Categories":0, "vDC_Description":"",
"Approvers":"","Status":"Error(s):\nNo NIC configuration found.", "Tag":null}],"columnMetaData":
null,"reportParams":{}}, "serviceError":null, "serviceName":"InfraMgr", "opName":"userAPIGetAllVDCs"
}

Step 3 Create a service request for choosing the VDC on which the VM is provisioned using the userAPICreateVDC API. An
approver approves the service request and the user is notified about the VM provisioning using this VDC. The system
policy, computing policy, network policy, storage policy, and the cost model applicable to the VDC are selected. The
number of days to wait before deleting an inactive VM is selected. A self-service policy which defines the tasks or actions
that can be performed on the VDC is selected.
Request:
/app/api/rest?formatType=json&opName=userAPICreateVDC&opData={param0:{"vdcName":"sdk",
"vdcDescription":"sdk vdc", "cloudName":"VCenter","groupName":1, "approver1":"", "approver2":"",
"vdcSupportEmail":"","vdcCustomerNoticationEmail":"","systemPolicy":"Default System Policy",
"deploymentPolicy":"","slaPolicy":"" , "computingPolicy":"VCenter - Default Computing Policy",
"storagePolicy":"VCenter - Default Storage Policy", "networkPolicy":"VCenter - Default Network
Policy","costModel":"", "isLocked":false,"isDeletable":true,"inactivityPeriodForDeletion":-1,
"selfServiceEndUserPolicy":""}}

Response:
{ "serviceResult":true, "serviceError":null, "serviceName":"InfraMgr", "opName":"userAPICreateVDC"
}

List of Available Cisco UCS Director Reports
In the following table, reports are grouped by context. The same report (with the same reportID) may be used
for different contexts, and so may appear in multiple locations in this list.

Report IDs are always single strings without character spaces. Because some of these strings are very
long, they are broken across multiple lines within individual table cells below. If you perform an electronic
search for a full, exact reportId string, it may not return a result because the break inserts a character space;
search instead for a short unique string contained within the full reportId character string.

Note

Report TypeReport IDReport NameContext

SummarySUMMARY-V0SummaryAWS-EC2 cloud

TabularVMS-T0VMsAWS-EC2 cloud
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Report TypeReport IDReport NameContext

TabularIMAGES-T0ImagesAWS-EC2 cloud

TabularDELETED-VMS-T0Deleted VMsAWS-EC2 cloud

Bar ChartMEMORY-S0MemoryAWS-EC2 cloud

Bar ChartCPU-S0VPUAWS-EC2 cloud

Bar ChartDISK-S0DiskAWS-EC2 cloud

TrendTREND-MEMORY-H0Trend: MemoryAWS-EC2 cloud

TrendTREND-CPU-H0Trend: CPUAWS-EC2 cloud

TrendTREND-CPU-USAGE-H0Trend: CPU UsageAWS-EC2 cloud

TrendTREND-DISK-READS-&
-WRITES-(BYTES)-H0

Trend: Disk Reads &
Writes (bytes)

AWS-EC2 cloud

TrendTREND-DISK-READS-&
-WRITES-(OPS)-H0

Trend: Disk Reads &
Writes (ops)

AWS-EC2 cloud

TrendTREND-DISK-READS-&
-WRITES-(OPS)-H0

Trend: Disk Reads &
Writes (ops)

AWS-EC2 cloud

TrendTREND-NETWORK-USAGE-H0Trend: Network UsageAWS-EC2 cloud

TabularGROUPS-WITH-MOST
-CPU-USAGE-T0

Groups with Most CPU
Usage

AWS-EC2 cloud

TabularVMS-WITH-MOST -CPU-USAGE-T0VMs With Most
Trend:CPU Usage

AWS-EC2 cloud

TabularVMS-WITH-OVER-
UTILIZED-CPU-USAGE-T0

VMs With Over-Utilized
CPU Usage

AWS-EC2 cloud

TabularVMS-WITH-UNDER
-UTILIZED-CPU-USAGE-T0

VMs With Under-Utilized
CPU Usage

AWS-EC2 cloud

Tabular with
Actions

VOLUMES-X1VolumesAWS-EC2 cloud

Tabular with
Actions

SNAPSHOTS-X1SnapshotsAWS-EC2 cloud

SummarySUMMARY-V1SummaryAWS-EC2 cloud

TabularSP-STATUS-T0SP StatusAWS-EC2 cloud
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Report TypeReport IDReport NameContext

Bar ChartCPU-USAGE-(PERCENT)-S0CPU Usage (percent)AWS-EC2 vm

Bar ChartNETWORK-IN-S0Network InAWS-EC2 vm

Bar ChartNETWORK-OUT-S0Network OutAWS-EC2 vm

TrendTREND-CPU-USAGE-H0Trend: CPU UsageAWS-EC2 vm

TrendTREND-DISK-READS
-&-WRITES-(BYTES)-H0

Trend: Disk Reads &
Writes (bytes)

AWS-EC2 vm

TrendTREND-DISK-READS
-&-WRITES-(OPS)-H0

Trend: Disk Reads &
Writes (ops)

AWS-EC2 vm

TrendNETWORK-USAGE-H0Network UsageAWS-EC2 vm

TabularDEPLOYABILITY-ASSESSMENT-T45Deployability Assessmentcatalog

TabularVDCS-T0vDCscloud

TabularEVENTS-T0Eventscloud

Bar ChartNUMBER-OF-EVENTS
-BY-SEVERITY-S0

Number of Events by
Severity

cloud

TabularGROUPS-WITH-MOST
-NUMBER-OF-VMS-T0

GroupsWIthMost Number
of VMs

cloud

TabularVDCS-WITH-MOST
-NUMBER-OF-VMS-T0

vDCs With Most Number
of VMs

cloud

TabularVDCS-WITH-MOST-CPU-USAGE-T0vDCs With Most CPU
Usage

cloud

TabularVDCS-WITH-MOST
-MEMORY-USAGE-T0

vDCs With Most Memory
Usage

cloud

TabularVDCS-WITH-MOST
-DISK-USAGE-T0

vDCs With Most Disk
Usage

cloud

Tabular with
Actions

VM-ACTION-REQUESTS-X0VM Action Requestscloud, vm

SummarySUMMARY-V50Summarycompute_chassis

TabularSERVERS-T50Serverscompute_chassis

TabularFAN-MODULES-T50Fan Modulescompute_chassis
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Report TypeReport IDReport NameContext

TabularIO-MODULES-T50IO Modulescompute_chassis

TabularPOWER-SUPPLY-UNITS-T50Power Supply Unitscompute_chassis

TabularEVENTS-T50Eventscompute_chassis

SummarySUMMARY-V50Summarycompute_fbi

TabularPOWER-SUPPLY-UNITS-T50Power Supply Unitscompute_fbi

TabularFANS-T50Fanscompute_fbi

Tabular with
Actions

ETHERNET-PORTS-X50Ethernet Portscompute_fbi

Tabular with
Actions

FIBRE-CHANNEL-PORTS-X50Fibre Channel Portscompute_fbi

TrendTREND-ETHERNET-PORTS
-TOTAL-KILO-BYTES
-TRANSFERRED/RECEIVED-H50

Trend: Ethernet Ports Total
Kilo Bytes
Transferred/Received

compute_fbi

TrendTREND-FIBRE-CHANNEL
-PORTS-TOTAL-KILO-BYTES
-TRANSFERRED/RECEIVED-H50

Trend: Fibre Channel Ports
Total Kilo Bytes
Transferred/Received

compute_fbi

TrendTREND-CPU-UTILIZATION-H50Trend: CPU Utilizationcompute_fbi

TrendTREND-MEMORY-H50Trend: Memorycompute_fbi

TabularEVENTS-T50Eventscompute_fbi

SummaryPORT-SUMMARY-V50Port Summarycompute_fbi_port

TabularLOCAL-DISKS-T50Local Diskscompute_server

TabularMEMORY-UNITS-T50Memory Unitscompute_server

TabularPROCESSOR-UNITS-T50Processor Unitscompute_server

Tabular with
Actions

INTERFACE-CARDS-X50Interface Cardscompute_server

TabularSERVICE-REQUEST-DETAILS-T50Service Request Detailscompute_server

TrendTREND-MOTHERBOARD
-INPUT-CURRENT-RECEIVED-H50

Trend: MotherBoard Input
Current Received

compute_server
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Report TypeReport IDReport NameContext

TrendTREND-MOTHERBOARD
-INPUT-VOLTAGE-RECEIVED-H50

Trend: MotherBoard Input
Voltage Received

compute_server

TrendTREND-MOTHERBOARD
-CONSUMED-POWER-H50

Trend: MotherBoard
Consumed Power

compute_server

TrendTREND-MOTHERBOARD
-SENS-IO-TEMPERATURE-H50

Trend: MotherBoard Sens
IO Temperature

compute_server

TrendTREND-MOTHERBOARD
-SENS-REAR-TEMPERATURE-H50

Trend: MotherBoard Sens
Rear Temperature

compute_server

TrendTREND-MEMORY-UNIT
-TEMPERATURE-H50

Trend: Memory Unit
Temperature

compute_server

TrendTREND-PROCESSOR-UNIT
-CURRENT-H50

Trend: Processor Unit
Current

compute_server

TrendTREND-PROCESSOR-UNIT
-TEMPERATURE-H50

Trend: Processor Unit
Temperature

compute_server

SummarySUMMARY-V50Summarycompute_server

TabularEVENTS-T50Eventscompute_server

TabularDCE-INTERFACES-T50DCE Interfacescompute_server
_adapter_unit

TabularHBAS-T50HBAscompute_server
_adapter_unit

TabularNICS-T50NICscompute_server
_adapter_unit

Tabular with
Actions

ADD/EDIT-TASKS-X46Add/Edit Taskscustom_actions

TabularSTORAGE-ACCOUNTS-T51Storage Accountsdatacenter

TabularTOP-5-VOLUME-TOTAL
-USED-STORAGE-T9999

Top 5 Volume Total-Used
Storage

datacenter

TabularTOP-5-LUN-TOTAL-USED
-STORAGE-T9999

Top 5 Lun Total-Used
Storage

datacenter

SummarySUMMARY-V51Summarydatacenter

Bar ChartVOLUMES-TOTAL-VS-USED-S51Volumes: Total vs Useddatacenter
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Report TypeReport IDReport NameContext

Bar ChartLUNS-TOTAL-VS-USED-S51LUNs: Total vs Useddatacenter

Pie ChartAGGREGATES-FREE-VS -USED-S51Aggregates: Free vs Useddatacenter

Tabular with
Actions

UCSM-ACCOUNTS-X50UCSM Accountsdatacenter

TabularCHASSIS-T50Chassisdatacenter

TabularFABRIC-INTERCONNECTS-T9999Fabric Interconnectsdatacenter

TabularSERVER-POOLS-T9999Server Poolsdatacenter

SummarySUMMARY-V50Summarydatacenter

TabularSERVICE-PROFILES-T9999Service Profilesdatacenter

TabularPROCESSOR-UNITS-T9999Processor Unitsdatacenter

TabularMEMORY-UNITS-T9999Memory Unitsdatacenter

TabularLOCAL-DISKS-T9999Local Disksdatacenter

TabularIO-MODULES-T9999IO Modulesdatacenter

Tabular with
Actions

MANAGED-NETWORK-
ELEMENTS-X52

Managed Network
Elements

datacenter

TabularVTP-STATUS-T52VTP Statusdatacenter

TabularPRIVATE-VLANS-T52Private VLANsdatacenter

TabularL2-NEIGHBORS-T52L2 Neighborsdatacenter

TabularPORT-PROFILES-T52Port Profilesdatacenter

TabularVM-NETWORK-DETAILS-T52VM Network Detailsdatacenter

TabularHOST-NETWORK-DETAILS-T52Host Network Detailsdatacenter

TabularVSANS-T52VSANsdatacenter

Tabular with
Actions

VLANS-X52VLANsdatacenter

Tabular with
Actions

HP-ACCOUNTS-X50HP Accountsdatacenter

TabularDHCP-LOG-T50DHCP Logdatacenter
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Report TypeReport IDReport NameContext

Tabular with
Actions

PXE-BOOT-REQUESTS-X50PXE Boot Requestsdatacenter

SummarySUMMARY-V0Summaryglobal

TabularCLOUDS-T0Cloudsglobal

TabularVDCS-T0vDCsglobal

TabularCLUSTERS-T0Clustersglobal

TabularVMS-T0VMsglobal

TabularHOST-NODE-STATUS-T0Host Node Statusglobal

TabularHOST-NODE-INVENTORY-T0Host Node Inventoryglobal

TabularRESOURCE-POOLS-T0Resource Poolsglobal

TabularEVENTS-T0Eventsglobal

TabularIMAGES-T0Imagesglobal

TabularDELETED-VMS-T0Deleted VMsglobal

TabularSYSTEM-HEALTH-T30System Healthglobal

Pie ChartACTIVE-VM-DISTRIBUTION-
BY-CLOUD-S0

Active VM Distributionglobal

Pie ChartACTIVE-VMS-PUBLIC-VS
-PRIVATE-CLOUDS-S0

Active VMs Public vs
Private By Clouds

global

Bar ChartMEMORY-S0Memoryglobal

Bar ChartCPU-S0CPUglobal

Bar ChartDISK-S0Diskglobal

Pie ChartPRIVATE-CLOUD-STORAGE
-CAPACITY-S1

Private Cloud Storage
Capacity

global

Pie ChartPRIVATE-CLOUD-FREE-STORAGE-S1Private Cloud Free Storageglobal

Pie ChartPRIVATE-CLOUD-USED-STORAGE-S1Private CloudUsed Storageglobal

Bar ChartSTORAGE-CAPACITY-PER-
STORAGE-TYPE-S1

Storage Capacity Per
Storage Type

global
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Report TypeReport IDReport NameContext

Bar ChartUSED-STORAGE-PER-STORAGE-TYPE-S1Used Storage Per Storage
Type

global

Bar ChartFREE-STORAGE-PER-STORAGE-TYPE-S1Free Storage Per Storage
Type

global

Bar ChartTOP-5-DATASTORES-MOST-USED-S1Top 5 Datastores Most
Used

global

Bar ChartTOP-5-DATASTORES-LEAST-USED-S1Top 5 Datastores Least
Used

global

Bar ChartNUMBER-OF-EVENTS-S0Number of Eventsglobal

TrendTREND-NUMBER-OF-HOST-NODES-H0Trend: Number of Host
Nodes

global

TrendTREND-MEMORY-H0Trend: Memoryglobal

TrendTREND-STORAGE-CAPACITY,
-USED-&-FREE-H1

Trend: Storage Capacity,
Used & Free

global

TrendTREND-CPU-H0Trend: CPUglobal

TabularALL-VMWARE-ACTIVITY-T0All VMware Activityglobal

SummarySUMMARY-V1Summaryglobal

TabularSP-STATUS-T0SP Statusglobal

Bar ChartVMS-ACTIVE-VS-INACTIVE-S0VMs Active vs Inactiveglobal, cloud

TrendTREND-NUMBER-OF-VMS-H0Trend: Number of VMsglobal, cloud

TrendTREND-VM-ADDITIONS-&
-DELETIONS-H0

Trend: VM Additions &
Deletions

global, cloud

TabularNETAPPVOLUMESTABLE-T9999NetAppVolumesTableglobal_admin

TabularNETAPPVFILERVOLUMES
TABLE-T9999

NetAppVFilerVolumes
Table

global_admin

TabularNETAPPLUNSTABLE-T9999NetAppLunsTableglobal_admin

TabularNETAPPVFILERLUNSTABLE-T9999NetAppVFilerLunsTableglobal_admin

TabularNETAPPFILERSTABLE-T9999NetAppFilersTableglobal_admin
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TabularNETAPPINITIATORGROUPS
TABLE-T9999

NetAppInitiatorGroups
Table

global_admin

TabularNETAPPVFILERINITIATOR
GROUPSTABLE-T9999

NetAppVFilerInitiator
Groups Table

global_admin

TabularNETAPPIPSPACESTABLE-T9999NetAppIPSpacesTableglobal_admin

TabularNETAPPVFILERSTABLE-T9999NetAppVFilersTableglobal_admin

TabularNETAPPAGGREGATESTABLE-T9999NetAppAggregatesTableglobal_admin

TabularNETAPPONTAPACCOUNTS
TABLE-T9999

NetAppONTAPAccounts
Table

global_admin

TabularNETAPPDFMACCOUNTS
TABLE-T9999

NetAppDFMAccounts
Table

global_admin

TabularNETAPPDFMFILERTABLE-T9999NetAppDFMFiler Tableglobal_admin

TabularNETAPPONTAPFILERTABLE-T9999NetAppONTAPFiler Tableglobal_admin

TabularNETAPPONTAPVFILERS
TABLE-T9999

NetAppONTAPvFilers
Table

global_admin

TabularNETAPPUNASSIGNEDIPSPACES
TABLE-T9999

NetAppUnAssignedIP
SpacesTable

global_admin

TabularNETAPPINTERFACESTABLE-T9999NetAppInterfacesTableglobal_admin

TabularNETAPPVLANPHYSICALINTERFACES
TABLE-T9999

NetAppVLANPhysical
InterfacesTable

global_admin

TabularNETAPPINTERFACESVFILERS
ASSIGNEDTABLE-T9999

NetAppInterfacesvFilers
Assigned Table

global_admin

TabularNETAPPDFMVFILERSTABLE-T9999NetAppDFMvFilersTableglobal_admin

TabularNETAPPDFMVOLUMEDATASET
TABLE-T9999

NetAppDfmVolume
DatasetTable

global_admin

TabularNETAPPDFMLUNDATASET
TABLE-T9999

NetAppDfmLUN
DatasetTable

global_admin

TabularNETAPPDFMGROUPTABLE-T9999NetAppDfmGroupTableglobal_admin

TabularNETAPPDFMPROVISIONPOLICY
TABLE-T9999

NetAppDfmProvision
PolicyTable

global_admin
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TabularNETAPPDFMSTORAGESERVICE
TABLE-T9999

NetAppDfmStorage
ServiceTable

global_admin

TabularNETAPPUNASSIGNEDDATASET
TABLE-T9999

NetAppUnAssigned
DatasetTable

global_admin

TabularNETAPPASSIGNEDDATASET
TABLE-T9999

NetAppAssignedDatasetTableglobal_admin

TabularNETAPPDATASETTABLE-T9999NetAppDatasetTableglobal_admin

TabularNETAPPDATASETMEMBER
LUNTABLE-T9999

NetAppDatasetMember
LUN Table

global_admin

TabularNETAPPREOURCEPOOLTABLE-T9999NetAppReourcePoolTableglobal_admin

TabularNETAPPGROUPASSIGNED
VFILERSTABLE-T9999

NetAppGroupAssigned
VFilersTable

global_admin

TabularPROVISIONING-POLICIES-T48Provisioning Policiesglobal_admin

TabularPROTECTION-POLICIES-T48Protection Policiesglobal_admin

TabularSTORAGE-SERVICES-T48Storage Servicesglobal_admin

TabularVFILER-TEMPLATES-T48vFiler Templatesglobal_admin

TabularONCOMMAND-DATASETS-T48OnCommand Datasetsglobal_admin

TabularONCOMMAND-GROUPS-T48OnCommand Groupsglobal_admin

TabularRESOURCE-POOL-T48Resource Poolglobal_admin

TabularUIMENUITEMTABLE-T9999UIMenuItemTableglobal_admin

TabularUIOPERATIONTABLE-T9999UIOperationTableglobal_admin

Tabular with
Actions

CUSTOMER-ORGANIZATIONS-X23Customer Organizationsglobal_admin

TabularCUSTOMER-ORGANIZATIONS-T23Customer Organizationsglobal_admin

TabularCUSTOMER-ORGANIZATIONS-T23Customer Organizationsglobal_admin

Tabular with
Actions

MSP-ORGANIZATIONS-X23MSP Organizationsglobal_admin

TabularMSP-ORGANIZATIONS-T23MSP Organizationsglobal_admin
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Tabular with
Actions

LOGIN-PAGE-BRANDING-X23Login Page Brandingglobal_admin

TabularLOGIN-PAGE-BRANDING-T23Login Page Brandingglobal_admin

Tabular with
Actions

LOGIN-USERS-X23Login Usersglobal_admin

TabularLOGIN-USERS-T23Login Usersglobal_admin

OtherCURRENT-ONLINE-USERS-X23Current Online Usersglobal_admin

Tabular with
Actions

VIRTUAL-ACCOUNTS-X22Virtual Accountsglobal_admin

TabularVIRTUAL-ACCOUNTS-T22Virtual Accountsglobal_admin

Tabular with
Actions

PHYSICAL-ACCOUNTS-X24Physical Accountsglobal_admin

TabularPHYSICAL-ACCOUNTS-T24Physical Accountsglobal_admin

Tabular with
Actions

CATALOG-X40Catalogglobal_admin

TabularUCSORGANIZATION TABLE-T9999UcsOrganizationTableglobal_admin

TabularUCSSERVERTABLE-T9999UcsServerTableglobal_admin

TabularUCSSERVICEPROFILETABLE-T9999UcsServiceProfileTableglobal_admin

TabularUCSSERVERPOOLTABLE-T9999UcsServerPoolTableglobal_admin

TabularUCSBOOTPOLICYTABLE-T9999UcsBootPolicyTableglobal_admin

Tabular with
Actions

DATA-CENTERS-X24Data Centersglobal_admin

TabularDATA-CENTERS-T24Data Centersglobal_admin

Tabular with
Actions

STORAGE-POLICY-X47Storage Policyglobal_admin

Tabular with
Actions

NETWORK-POLICY-X47Network Policyglobal_admin

Tabular with
Actions

VHBA-X47vHBAglobal_admin
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Tabular with
Actions

VNIC-X47vNICglobal_admin

Tabular with
Actions

PLACEMENT-POLICY-X47Placement Policyglobal_admin

TabularDEVICEZONESTABLE-T9999deviceZonesTableglobal_admin

Tabular with
Actions

VENDOR-VALIDATED-
DESIGNS-X24

Vendor Validated Designsglobal_admin

TabularHPSERVERTABLE-T9999HpServerTableglobal_admin

Tabular with
Actions

REPORTS-CUSTOMIZATION-X20Reports Customizationglobal_admin

Tabular with
Actions

AMAZON-DEPLOYMENT-POLICY-X41Amazon Deployment
Policy

global_admin

TabularAMAZON-DEPLOYMENT-POLICY-T41Amazon Deployment
Policy

global_admin

Tabular with
Actions

VMWARE-DEPLOYMENT-POLICY-X21VMware Deployment
Policy

global_admin

TabularVMWARE-DEPLOYMENT-POLICY-T21VMware Deployment
Policy

global_admin

Tabular with
Actions

RESOURCE-ALLOCATION-POLICY-X21Resource Allocation Policyglobal_admin

TabularRESOURCE-ALLOCATION-POLICY-T21Resource Allocation Policyglobal_admin

Tabular with
Actions

RACKSPACE-DEPLOYMENT-POLICY-X41Rackspace Deployment
Policy

global_admin

TabularRACKSPACE-DEPLOYMENT-POLICY-T41Rackspace Deployment
Policy

global_admin

Tabular with
Actions

KVM-DEPLOYMENT-POLICY-X41KVM Deployment Policyglobal_admin

TabularKVM-DEPLOYMENT-POLICY-T41KVM Deployment Policyglobal_admin

Tabular with
Actions

VMWARE-NETWORK-POLICY-X44VMware Network Policyglobal_admin

TabularVMWARE-NETWORK- POLICY-T44VMware Network Policyglobal_admin
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Tabular with
Actions

NETWORK-PROVISIONING-
POLICY-X44

Network Provisioning
Policy

global_admin

TabularNETWORK-PROVISIONING-
POLICY-T44

Network Provisioning
Policy

global_admin

Tabular with
Actions

VLAN-POOL-POLICY-X44VLAN Pool Policyglobal_admin

TabularVLAN-POOL-POLICY-T44VLAN Pool Policyglobal_admin

Tabular with
Actions

VIRTUAL-STORAGE-
CATALOG-X43

Virtual Storage Catalogglobal_admin

TabularVIRTUAL-STORAGE-CATALOG-T43Virtual Storage Catalogglobal_admin

Tabular with
Actions

VMWARE-STORAGE- POLICY-X43VMware Storage Policyglobal_admin

TabularVMWARE-STORAGE- POLICY-T43VMware Storage Policyglobal_admin

Tabular with
Actions

VMWARE-SYSTEM-POLICY-X41VMware Storage Policyglobal_admin

TabularVMWARE-SYSTEM-POLICY-T41VMware Storage Policyglobal_admin

Tabular with
Actions

VMWARE-COMPUTING-
POLICY-X42

VMwareComputing Policyglobal_admin

TabularVMWARE-COMPUTING-
POLICY-T42

VMwareComputing Policyglobal_admin

Tabular with
Actions

KVM-COMPUTING-POLICY-X42KVM Computing Policyglobal_admin

TabularKVM-COMPUTING-POLICY-T42KVM Computing Policyglobal_admin

Tabular with
Actions

COST-MODEL-X41Cost Modelglobal_admin

TabularCOST-MODEL-T41Cost Modelglobal_admin

Tabular with
Actions

STORAGE-TIER-COST-MODEL-X41Storage Tier Cost Modelglobal_admin

TabularSTORAGE-TIER-COST-MODEL-T41Storage Tier Cost Modelglobal_admin

Tabular with
Actions

OS-LICENSE-X41OS Licenseglobal_admin
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TabularOS-LICENSE-T41OS Licenseglobal_admin

Tabular with
Actions

NETWORK-SERVICES-AGENTS-X24Network Services Agentsglobal_admin

Tabular with
Actions

DISCOVERED-DEVICES-X24Discovered Devicesglobal_admin

Tabular with
Actions

ACTIVE-MODULES-X26Active Modulesglobal_admin

TabularACTIVE-MODULES-T26Active Modulesglobal_admin

Tabular with
Actions

MODULES-X26Modulesglobal_admin

TabularMODULES-T26Modulesglobal_admin

Tabular with
Actions

MODULE-SNAPSHOTS-X26Module Snapshotsglobal_admin

TabularMODULE-SNAPSHOTS-T26Module Snapshotsglobal_admin

TabularVMWAREVSWITCH TABLE-T9999vmwareVSwitchTableglobal_admin

TabularPORTGROUPS-T9999portGroupsglobal_admin

Tabular with
Actions

WORKFLOWS-X46Workflowsglobal_admin

Tabular with
Actions

USER-VM-ACTION-POLICY-X46User VM Action Policyglobal_admin

Tabular with
Actions

CONTEXT-WORKFLOW-
MAPPING-X46

Context Workflow
Mapping

global_admin

Tabular with
Actions

TEMPLATES-X46Templatesglobal_admin

Tabular with
Actions

WORKFLOW-SCHEDULES-X46Workflow Schedulesglobal_admin

Tabular with
Actions

CUSTOM-APPROVAL-TASKS-X46Custom Approval Tasksglobal_admin

Tabular with
Actions

LICENSE-X20Licenseglobal_admin
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TabularTABULARLOV.SYSTEM.ADVANCED.
PROPERTY.REPORT-T9999

tabularlov.system.advanced.property.reportglobal_admin

TabularCHANGE-RECORDS-T25Change Recordsglobal_admin

Tabular with
Actions

APPLICATION-CATEGORIES-X20Application Categoriesglobal_admin

Tabular with
Actions

SYSTEM-TASKS-X20System Tasksglobal_admin

TabularSYSTEM-TASKS-T20System Tasksglobal_admin

Tabular with
Actions

LDAP-INTEGRATION-X23LDAP Integrationglobal_admin

TabularLDAP-INTEGRATION-T23LDAP Integrationglobal_admin

Tabular with
Actions

VIRTUAL-CONSOLE-SERVERS-X24Virtual Console Serversglobal_admin

Tabular with
Actions

TRIGGERS-X46Triggersglobal_admin

Tabular with
Actions

VDC-X45vDCglobal_admin,
group

Tabular with
Actions

VDC-SERVICE-PROFILES-X45vDC Service Profilesglobal_admin,
group

TabularCATALOG-T40Catalogglobal_admin,
group

TabularVDCS-T14vDCsgroup

Tabular with
Actions

PORT-GROUPS-X14Port Groupsgroup

Tabular with
Actions

VFILERS-X15vFilersgroup

Tabular with
Actions

SERVERS-X15Serversgroup

Tabular with
Actions

SERVICE-PROFILES-X15Service Profilesgroup

Tabular with
Actions

SERVICE-REQUESTS-X10Service Requestsgroup

Cisco UCS Director REST API Getting Started Guide, Release 5.5    
33

Getting Started with Cisco UCS Director REST API
List of Available Cisco UCS Director Reports



Report TypeReport IDReport NameContext

Tabular with
Actions

ARCHIVED-SERVICE-
REQUESTS-X10

Archived Service Requestsgroup

Tabular with
Actions

USERS-X13Usersgroup

TabularVMS-T14VMsgroup

TabularRESOURCE-LIMITS-T13Resource Limitsgroup

SummarySUMMARY-V13Summarygroup

TabularTOP-5-FAILURE-REASONS-T10Top 5 Failure Reasonsgroup

TrendTREND-NETWORK-USAGE-H14Trend: Network Usagegroup

TrendTREND-CPU-USAGE-H14Trend: CPU Usagegroup

TrendTREND-DISK-USAGE-H14Trend: Disk Usagegroup

TrendTREND-CONSOLIDATED-
RESOURCE-USAGE-H14

Trend: Consolidated
Resource Usage

group

Bar ChartVMS-ACTIVE-VS-INACTIVE-S13VMs Active vs Inactivegroup

Tabular with
Actions

VLANS-X15VLANsgroup

TabularRESOURCE-ACCOUNTING-T12Resource Accountinggroup

TabularRESOURCE-ACCOUNTING-DETAILS-T12Resource Accounting
Details

group

TabularCHARGEBACK-T12Chargebackgroup

TabularRESOURCE-ACCOUNTING-
DETAILS-T85

Resource Accounting
Details

group

TabularCHARGEBACK-T85Chargebackgroup

SummaryCURRENT-MONTH-SUMMARY-V12Current Month Summarygroup

SummaryPREVIOUS-MONTH-SUMMARY-V12Previous Month Summarygroup

Pie ChartCURRENT-MONTH-COST-
SUMMARY-S12

Current Month Cost
Summary

group

Pie ChartPREVIOUS-MONTH-COST-
SUMMARY-S12

Previous Month Cost
Summary

group
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Pie ChartCURRENT-MONTH-TOP-5
-APPLICATIONS-S12

Current Month Top 5
Applications

group

Pie ChartPREVIOUS-MONTH-TOP-5
-APPLICATIONS-S12

Previous Month Top 5
Applications

group

TrendTREND-BUDGET-SPENDING-H12Trend: Budget Spendinggroup

TrendTREND-TOTAL-COST-H12Trend: Total Costgroup

TrendTREND-VM-COST-H12Trend: VM Costgroup

TrendTREND-CPU-COST-H12Trend: CPU Costgroup

TrendTREND-MEMORY-COST-H12Trend: Memory Costgroup

TrendTREND-NETWORK-COST-H12Trend: Network Costgroup

Tabular with
Actions

PAYMENT-INFORMATION-X10Payment Informationgroup

Tabular with
Actions

CUSTOMER-FUNDS-X10Customer Fundsgroup

TabularRESOURCE-ACCOUNTING-
DETAILS-T10

Resource Accounting
Details

group

SummarySUMMARY-V0Summaryhostnode

TabularVMS-T0VMshostnode

TabularEVENTS-T0Eventshostnode

TabularDELETED-VMS-T0Deleted VMshostnode

Tabular with
Actions

ILO-SERVERS-X50ILO Servershp, datacenter

TabularSERVER-NICS-T50Server NICshp_server

TabularSERVER-MEMORY-T50Server Memoryhp_server

TabularSERVER-PROCESSOR-T50Server Processorhp_server

TabularSERVER-SLOTS-T50Server Slotshp_server

TrendTREND-NUMBER-OF- HOST
-NODES-H0

Trend: Number of Host
Nodes

HyperV cloud
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TrendTREND-MEMORY-H0Trend: MemoryHyperV cloud

TrendTREND-CPU-H0Trend: CPUHyperV cloud

SummarySUMMARY-V0SummaryHyperV cloud

TabularCLUSTERS-T0ClustersHyperV cloud

TabularHOST-NODE-STATUS-T0Host Node StatusHyperV cloud

TabularHOST-NODE-INVENTORY-T0Host Node InventoryHyperV cloud

TabularVMS-T0VMsHyperV cloud

TabularDELETED-VMS-T0Deleted VMsHyperV cloud

TabularDATA-STORES-T0Data StoresHyperV cloud

TabularIMAGES-T9999ImagesHyperV cloud

Bar ChartMEMORY-S0MemoryHyperV cloud

Bar ChartCPU-S0CPUHyperV cloud

Bar ChartDISK-S0DiskHyperV cloud

SummarySUMMARY-V0SummaryHyperV cluster

TabularHOST-NODE-STATUS-T0Host Node StatusHyperV cluster

TabularHOST-NODE-INVENTORY-T0Host Node InventoryHyperV cluster

TabularVMS-T0VMsHyperV cluster

TabularEVENTS-T0EventsHyperV cluster

Bar ChartCPU-USAGE-S0CPU UsageHyperV hostnode

Bar ChartCPU-USAGE(MHZ)-S0CPU Usage(Mhz)HyperV hostnode

Bar ChartMEMORY-USAGE-S0Memory UsageHyperV hostnode
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